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The Infiniium Time Correlation Fixture

The Agilent Technologies E5850A Time Correlation Fixture automates 
and simplifies the tedious process of setting up an oscilloscope and a 
logic analyzer to cross-trigger and make time-correlated 
measurements. It works with Agilent 167XX Logic Analysis Systems 
(with 1655X and/or 167XX analysis modules), and Agilent Infiniium 
548XX oscilloscopes.

 

Getting Started • “Overview” on page 8

• “Installing the Software” on page 45

• “Connecting the Fixture” on page 9

• “Configuring the Software” on page 20

• “Making a Measurement” on page 23 

Advanced Tasks • “Advanced Software Features” on page 22

• “Setting Up the Infiniium Time Correlation Tool in the Workspace” on 
page 47

• “Loading & Saving Configurations” on page 49

• Manual Skew Adjustment (Advanced Tab) (see page 32) 

Reference and 
Troubleshooting

• “Reference” on page 37

• “Troubleshooting” on page 50 
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Chapter 1: The Infiniium Time Correlation Fixture
Overview
Overview

The Agilent Technologies E5850A Time Correlation Fixture automates 
and simplifies the tedious process of setting up an oscilloscope and a 
logic analyzer to cross-trigger and make time-correlated 
measurements. It measures skew between the two instruments and 
configures them for cross-triggering. It is compatible with Agilent 
167XX Logic Analysis Systems (with 1655X and/or 167XX analysis 
modules) and Agilent Infiniium 548XX oscilloscopes. 

The Agilent E5850A is comprised of a Time Correlation Fixture and 
software to automate the correlation tasks. The Agilent E5850A 
produces mixed displays of correlated logic analysis and oscilloscope 
waveforms and coordinates marker moves between the Logic Analysis 
System and the Infiniium 548XX.

The software, which runs on the Agilent 167XX Logic Analysis System, 
accomplishes its tasks by sending commands to the Agilent Infiniium 
548XX Oscilloscope via LAN. 

Show me a picture of the front (see page 18) 
Show me a picture of the back (see page 19)

Next step: “Installing the Software” on page 45
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Chapter 1: The Infiniium Time Correlation Fixture
Connecting the Fixture
Connecting the Fixture

To perform time correlated measurements, the Agilent E5850A time 
correlation fixture must be connected to the Agilent 16700-series logic 
analysis system and the Agilent Infiniium 548XX oscilloscope. 

Follow these steps to connect the time correlation fixture to the logic 
analysis system and the oscilloscope.

1. “Connect the LAN” on page 10

2. “Connect the BNC cables” on page 14

3. “Connect the Oscilloscope” on page 15

4. “Connect the Analyzer” on page 16

5. “Connect the Power Supply” on page 17 

After you have connected the time correlation fixture, configured the 
software, and run the autodeskew operation, you can remove the 
oscilloscope and logic analyzer channel connections from the front of 
the time correlation fixture. At this point, all of the channels are 
available for your use. However, the four BNC cables (connected to the 
logic analyzer and the Infiniium) and the power supply must remain 
connected to the time correlation fixture whenever you are performing 
a time correlated measurement. 

NOTE: Remember that the skew is affected by cable lengths, probe types, the 
instruments themselves and the particular slot an analysis module is in. If you 
change any of these you will need to run auto deskew again. To re-run auto 
deskew, select the Time Correlate with Infiniium Oscilloscope button from 
the system window, then select Run Auto Deskew.
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Chapter 1: The Infiniium Time Correlation Fixture
Connect the LAN
Connect the LAN

The Agilent E5850A Time Correlation Fixture software uses a network 
connection between the 548XX Infiniium oscilloscope and the 16700-
series logic analysis system to produce time correlated measurements. 
The instruments may be connected on a local area network (LAN), or 
connected  point-to-point with a cross-over cable (which is supplied 
with the E5850A time correlation fixture). 

You may connect only one oscilloscope to the system for time 
correlated measurements. The system does not support the connection 
of two or more oscilloscopes at once. 

Point-to-Point 
Connection Setup

Configuring the point-to-point connection (see page 11) 

  

LAN Connection 
Setup

Configuring the logic analyzer LAN setup (see the Agilent Technologies 

16700A/B-Series Logic Analysis System help volume)

For instructions on making the LAN connection to the Infiniium 548XX 
oscilloscope, choose File -> Network -> Getting Started from the 
Infiniium main menu. 

Next step: “Connect the BNC cables” on page 14
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Chapter 1: The Infiniium Time Correlation Fixture
Point-to-point Networking
Point-to-point Networking

If you don’t typically network your 167XX Logic Analysis System or 
548XX Infiniium oscilloscope, it may be most convenient to set up a 
point-to-point connection between the instruments. 
 

LAN Crossover Cable To do this you will need a crossover LAN cable (such as Agilent part 
number 5061-7342, included with the E5850A). A LAN crossover cable 
is often called a "blue cable", because often times the cable is blue or 
the ends of the cable are marked in blue. Crossover cables also come in 
colors other than blue. 

You can also identify a crossover cable by looking at the connectors. 
They are usually clear and you can see the colored wires connected to 
each contact. On a crossover cable the two ends will be wired 
differently from one another. Simply connect one end of the crossover 
cable to the network interface on your 167XX Logic Analysis System 
and the other end to the network interface on your 548XX Infiniium 
oscilloscope. 
 

Configure the 
Networking Software

You will need to configure the networking software on both 
instruments. 

Configure the 167XX Networking Software

On the 167XX Logic Analysis System, select the System Administration 
icon from the toolbar. In the dialog that pops up, select Network 

Setup... In the Network Setup dialog, select or enter the following: 

Networking? Standard 

Hostname logic 

Int. Address(IP) 192.0.2.232 

Gateway name (leave it blank) 

Gateway IP (leave it blank) 

Subnet Mask 255.255.255.0 
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Chapter 1: The Infiniium Time Correlation Fixture
Point-to-point Networking
Once these values are all entered, select the OK button at the bottom 
left of the dialog. This may cause a reboot, depending on the prior 
configuration of the networking software. If a reboot does occur, return 
to this dialog using the System Administration icon and Network 

Setup... button. Then select the Name Resolver... button. In the Name 
Resolution Dialog that pops up, Name Resolution by Host Table should 
be selected. In the input box below the Host Table label, enter:

192.0.2.231 infiniium 

Then select the Add button. Select the OK buttons on the Name 
Resolution and Network Setup dialogs. Now, when you use the E5850A 
software, you can enter either "192.0.2.231" or "infiniium" as the 
Infiniium Host Name or IP in either the Setup Assistant or the 
E5850A main dialog.

Configure the Infiniium Networking Software

To configure the networking software on the 548XX Infiniium, enable 
the graphical interface by selecting the mouse icon in the upper right 
corner. Select File->Network->Properties. Make sure the following 
components are installed: 
Client for Microsoft Networks
LAN Card
NetBEUI
TCP/IP

After the components are all installed, select TCP/IP and then the 
Properties button. Select or enter the following:

IP Address Tab
Specify an IP address

IP Address 192.0.2.231 

Subnet Mask 255.255.255.0 

WINS Configuration Tab
Disable WINS Resolution

Gateway Tab
12



Chapter 1: The Infiniium Time Correlation Fixture
Point-to-point Networking
Remove any installed gateways

DNS Configuration Tab
Disable DNS

Select OK in the TCP/IP Properties dialog and the Network dialog. 
This may cause a reboot, depending on the prior configuration of the 
networking software. 

  

Test the Configuration When the Infiniium is ready you can test the configuration by selecting 
Ping... from the Networking Tab of the 167XX Logic Analysis System. 
Enter "infiniium" in the text box of the Ping dialog and select OK. A 
window will open and display messages like the following: 
64 bytes from 192.0.2.231: icmp_seq=0. time=0. ms

If you see no error messages, close the Ping window. Your point-to-
point connection is now established.

 

Next step: “Connect the BNC cables” on page 14
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Chapter 1: The Infiniium Time Correlation Fixture
Connect the BNC cables
Connect the BNC cables

Four BNC cables are provided with the Agilent E5850A Time 
Correlation Fixture. Use the four cables to connect the logic analysis 
system and the oscilloscope to the Time Correlation Fixture. Show me 
a picture (see page 19)

• Connect the first cable between the Time Correlation Fixture connector 
labeled TO PORT OUT and the connector on the back of the logic analysis 
system labeled PORT OUT.

• Connect the second cable between the Time Correlation Fixture connector 
labeled TO PORT IN and the connector on the back of the logic analyzer 
labeled PORT IN.

• Connect the third cable between the Time Correlation Fixture connector 
labeled TO AUX OUT and the connector on the front of the Agilent 
Infiniium 548XX oscilloscope labeled Aux Out.

• Connect the fourth cable between the Time Correlation Fixture connector 
labeled TO AUX TRIG IN and the connector on the front of the Agilent 
Infiniium 548XX oscilloscope labeled Aux Trig In (labeled Ext Trig on 2-
channel Infiniium oscilloscopes). 

These four BNC cables need to remain connected. The trigger signals 
are transmitted over these four cables.

Next step: “Connect the Oscilloscope” on page 15
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Chapter 1: The Infiniium Time Correlation Fixture
Connect the Oscilloscope
Connect the Oscilloscope

NOTE: It is important to use the same probes for the automatic deskew process as 
you use to make your target system measurements. This provides the best 
possible deskew accuracy. All connections must include a ground connection.

Connect the Agilent Infiniium 548XX oscilloscope channel 1 probe to 
any point labeled CAL on the front of the E5850A Time Correlation 
Fixture. Any point labeled CAL is equivalent to any other point labeled 
CAL. Show me a picture (see page 18)

For example: 

• If you are using a grabber probe to make target system measurements, 
connect the grabber probe to the cal terminal on the front of the time 
correlation fixture. Then connect the ground lead.

• If you are using a twin lead probe to make target system measurements, 
connect the twin lead probe to the Time Correlation Fixture. Then connect 
the ground lead.

• If you are using a sharp-tip probe to make target system measurements, 
connect the sharp tip probe to the CAL terminal on the front of the Time 
Correlation Fixture. Then connect the ground lead. 

Next step: “Connect the Analyzer” on page 16
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Chapter 1: The Infiniium Time Correlation Fixture
Connect the Analyzer
Connect the Analyzer

NOTE: It is important to use the same probes for the automatic deskew process as 
you use to make your target system measurements. This provides the best 
possible deskew accuracy. All connections must include a ground connection.

 

There are two ways to connect to the CAL and TRIG SENSE signals on 
the time correlation fixture: 

• Using flying leads

• Using high-density connectors (MICTOR or Samtec) 

Flying leads Connect pod 2, channel 0 of the logic analyzer you are using to any 
point labeled CAL on the front of the Time Correlation Fixture. If you 
are using multiple cards, use pod 2 of the master card. Include a 
ground connection.

Connect pod 2, channel 1 of the logic analyzer to either point labeled 
TRIG SENSE on the front of the Time Correlation Fixture. Include a 
ground connection. 

  

High-density 
connectors

• If you are using a MICTOR connector on your target system, use the 
MICTOR receptacle on the top of the Time Correlation Fixture, which 
includes both the CAL and TRIG SENSE connections. Be sure to connect 
pod 2 of the logic analyzer to the even receptacle of the MICTOR high-
density adapter cable. You can use a terminated or an unterminated high-
density adapter cable.

• If you are using Samtec connectors on your target system, use the Samtec 
receptacle on the top of the Time Correlation Fixture, which includes both 
the CAL and TRIG SENSE connections. 

Show me a picture (see page 18) 

Next step: “Connect the Power Supply” on page 17
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Chapter 1: The Infiniium Time Correlation Fixture
Connect the Power Supply
Connect the Power Supply

  Connect the power supply to the Time Correlation Fixture as follows:  

• Connect the AC power cable to the AC/DC adapter 

WARNING: Shock hazard. Use only the 0950-2546 power supply.

CAUTION: Equipment damage. Use only the 0950-2546 power supply and 
cord. 

• Connect the DC power cable from the AC/DC adapter to the jack on the 
back of the Time Correlation Fixture. 

Show me a picture (see page 19) 

Next step: “Configuring the Software” on page 20
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Chapter 1: The Infiniium Time Correlation Fixture
Front View of Time Correlation Fixture
Front View of Time Correlation Fixture
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Back View of Time Correlation Fixture
Back View of Time Correlation Fixture
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Chapter 1: The Infiniium Time Correlation Fixture
Configuring the Software
Configuring the Software

The time correlation 
setup assistant

The time correlation setup assistant will help you configure the 
E5850A software for most applications. To access this setup assistant, 
open the System window and select the Time Correlate with 

Infiniium Oscilloscope button in the lower right corner.   

  Note that running the time correlation setup assistant or the auto 
deskew will overwrite the current intermodule bus setup. If you have 
created a unique intermodule bus setup, you may want to save the 
configuration so you can return to it later. If you need to use your 
unique intermodule bus setup with the time correlation tool, you will 
need to set up the time correlation tool first, then recreate your 
intermodule bus setup.

Advanced users may want to refer to the procedure “Setting Up the 
Infiniium Time Correlation Tool in the Workspace” on page 47 instead.

Running the time 
correlation setup 
assistant

Selecting the Time Correlate with Infiniium Oscilloscope button will 
run the time correlation setup assistant only if the Infiniium tool is not 
present in the system workspace. If an Infiniium tool is in the System 
Workspace and the button is selected, the Infiniium time correlation 
setup window will be displayed. If you want to re-run the time 
correlation setup assistant, click on the System Workspace icon in the 
main System window and delete the Infiniium tools by right-clicking on 
them and selecting delete. Then click on the Time Correlate with 

Infiniium Oscilloscope button in the main System window.
20



Chapter 1: The Infiniium Time Correlation Fixture
Configuring the Software
For more information, see: 

• “Infiniium Host Name” on page 27

• “Trigger Direction” on page 25

• “Analyzer Selection” on page 26 

When you’ve made your choices, select the Next --> button to proceed. 
This will display a screen with instructions for connecting the 167XX 
logic analysis system and the Infiniium 548XX to the E5850A time 
correlation fixture. Make all the connections. Then, when you select 
the Done button, the software will add the Infiniium tool to the 
Workspace, set up the intermodule bus, and Run Auto Deskew.... The 
skew between the Infiniium and the logic analyzer will be measured (in 
both directions) and the system will be prepared to make a 
measurement. 

If you need to customize the setup, click on the appropriate tab(s) in 
the Infiniium<1> window. See “Advanced Software Features” on 
page 22. 

Next step: “Making a Measurement” on page 23
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Advanced Software Features
Advanced Software Features

  

If you need to change the default configuration that the time 
correlation setup assistant has created, click on the appropriate tab in 
the Infiniium<1> window of the logic analysis system and make your 
changes. Be aware that changing the configuration may cause the time 
correlation software to stop working. If this happens, you can use the 
time correlation setup assistant to re-configure the software for correct 
operation. See “Re-running the Setup Assistant” on page 51. 

Software 
Configuration

• “Connect Tab” on page 28

• “Markers Tab and Coordinated Marker Moves” on page 29

• “Advanced Tab” on page 32

• “Comments Tab” on page 35 

Next step: “Making a Measurement” on page 23
22



Chapter 1: The Infiniium Time Correlation Fixture
Making a Measurement
Making a Measurement

  

When the calibration is complete the Infiniium Time Correlation 
window will be displayed (titled Infiniium<1>), and you may proceed 
with your measurements as follows:

• Disconnect the oscilloscope probe and the logic analyzer leads

• Do not disconnect the BNC connections

• Press the Run button on the logic analyzer front panel

• Select Window in the menu bar at the top of the logic analyzer screen

• Select the logic analyzer you are using (A, B, or C, etc.)

• Select the Waveform pop-out list to view your measurement results 
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Chapter 1: The Infiniium Time Correlation Fixture
Making a Measurement
  

A note about trigger 
setups

  

Analyzer Triggers Infiniium

When the software is configured for Analyzer triggers Infiniium you 
can set any trigger condition you desire in the logic analyzer. However, 
do not change the Infiniium's trigger setup. See also “General 
Triggering Problems” on page 53.

Infiniium Triggers Analyzer

When the software is configured for Infiniium triggers Analyzer you 
may set any trigger condition you desire in the Infiniium. However, do 
not change the logic analyzer's trigger setup. See also “General 
Triggering Problems” on page 53.
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Trigger Direction
Trigger Direction

You can select the trigger direction in the Setup Assistant. Note that 
the Setup Assistant will measure skew in both directions so selecting a 
trigger direction at this point is just a convenience for your planned 
initial usage. The trigger direction can be changed later if you wish.

 

Back to “Configuring the Software” on page 20
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Chapter 1: The Infiniium Time Correlation Fixture
Analyzer Selection
Analyzer Selection

If your 167XX contains more than one analysis module that can be time 
correlated with Infiniium 548XX, a list will be presented. Select the 
analyzer you wish to correlate with.

 

Back to “Configuring the Software” on page 20
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Chapter 1: The Infiniium Time Correlation Fixture
Infiniium Host Name
Infiniium Host Name

Enter the Host Name or IP Address of the Infiniium 548XX you will be 
using for making time correlated measurements. To find the Infiniium’s 
IP address, choose Utilities -> GPIB Setup... from the Infiniium main 
menu and enter the number shown in the LAN Interface box. Include 
only the numbers and decimal points, not the brackets or text. For 
example: 130.29.124.34

Note that the time correlation setup assistant or auto deskew must be 
re-run if the Infiniium’s IP address is changed.

 

Back to “Configuring the Software” on page 20
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Connect Tab
Connect Tab

  

If a connection has already been established with the Infiniium, the 
Connect tab will display the Infiniium’s IP address, model number, and 
serial number.

To establish a LAN connection to the Infiniium, enter the Infiniium’s IP 
address in the Infiniium Host Name or IP box. Then press the Enter 
key on your keyboard or select the "Apply" button in the lower left 
corner of the "Infiniium<1>" window. Either of these actions will 
initiate an attempt to establish a LAN connection with the Infiniium.

If the software fails to make a network connection to the Infiniium you 
specify, a red error box will be displayed. Check the address you 
entered and the network setup on both the logic analysis system and 
the Infiniium.

If you change the Infiniium’s IP address the deskew calibration must be 
re-run.

 

Back to “Advanced Software Features” on page 22
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Markers Tab and Coordinated Marker Moves
Markers Tab and Coordinated Marker Moves

  

Marker moves can be coordinated between the Logic Analysis System 
and the Infiniium. Markers are coordinated in time relative to the 
trigger taking the measured skew into account. The options for marker 
features are displayed under the Markers tab. By default all options 
are enabled.

On the Logic Analysis System the two global markers called G1 and G2 
are time coordinated among all Display Windows that are displaying 
measurements from a given Run Group. On the Infiniium there are two 
X-Axis (time) markers called Ax and Bx. Marker moves may be 
coordinated between G1 and Ax or between G2 and Bx. The option to 
coordinate between G1 and Bx or between G2 and Ax is not available.

Coordinated marker moves are useful for quickly identifying a given 
point in the trace on the separate Logic Analysis System and Infiniium 
displays. Even though all the waveforms are displayed on the Logic 
Analysis System the Infiniium generally provides a higher resolution 
display of the analog waveforms and has measurement capabilities not 
present in the Logic Analysis System Waveform display.

Infiniium Markers

Ax follows Logic Analyzer’s G1 When you move the G1 marker in the 
Logic Analysis System Waveform display a command is sent to the 
Infiniium to position the Ax marker at the same point in time.
29
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Markers Tab and Coordinated Marker Moves
Bx follows Logic Analyzer’s G2 When you move the G2 marker in the 
Logic Analysis System Waveform display a command is sent to the 
Infiniium to position the Bx marker at the same point in time.

Ax/Bx centered after move After either Ax or Bx are moved, the 
Infiniium display is centered on the marker that was just moved. This is 
most useful in conjunction with "Infiniium Ax follows G1" or "Infiniium 
Bx follows G2". In that case when you move the global marker in the 
Logic Analysis System Waveform display, the Infiniium marker is 
moved and the Infiniium display is centered on the new position of the 
marker.

If you are using a pointing device such as a mouse or track ball to move 
markers on the Infiniium, you should turn off the "Ax/Bx centered after 
move" option. This option interacts with mouse moves in sometimes 
confusing ways. This option works well with the marker move buttons 
on the Infiniium front panel.

If you are using Measurement Markers on the Infiniium you should turn 
all these options off since they will interfere with Measurement Marker 
operation.

Logic Analyzer Markers

G1 follows Infiniium’s Ax When you move the Ax marker on Infiniium 
the G1 marker in the Logic Analysis Waveform display is moved to the 
same point in time.

G2 follows Infiniium’s Bx When you move the Bx marker on Infiniium 
the G2 marker in the Logic Analysis Waveform display is moved to the 
same point in time.

Coordinated Marker Implementation Note

Markers, and in particular marker moves, are not identically 
implemented in the 167XX Logic Analysis System and the Infiniium 
oscilloscope. In the 167XX Logic Analysis System the new marker 
position is sent to all tools that are displaying a correlated 
measurement when the move completes. Moving a 167XX marker will 
cause a move of an Infiniium marker only when the move is complete. 
The Infiniium doesn’t have this same facility, so the 167XX polls the 
Infiniium for its marker positions, updating the 167XX markers as the 
30
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Markers Tab and Coordinated Marker Moves
Infiniium markers move.

 

Back to “Advanced Software Features” on page 22
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Advanced Tab
Advanced Tab

  

Save Infiniium Setup

When the Save Infiniium Setup box is checked, the Infiniium setup 
will be saved with the logic analyzer configuration when you save the 
logic analyzer configuration.

Enable Info Messages/Enable Warning Messages

Warning messages and information messages will be displayed by the 
Time Correlation Fixture software. These messages may be helpful the 
first few times you use the E5850A, but may become a nuisance after 
you are familiar with its operation. These messages can be turned off 
by deselecting the Enable Info Messages and/or Enable Warning 

Messages options. These options are saved when you save a logic 
analyzer configuration. 

Setting these options affects only the current instance of the Time 
Correlation Fixture software. The messages will appear again when the 
Time Correlation Fixture software is restarted.

Enable Waveform Auto Fit

Enabled by default. Resizes (usually increases height of) imported 
Infiniium waveforms in 167XX logic analysis system Waveform display 
for easy viewing. Makes the tallest imported waveform fill the allocated 
32
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Advanced Tab
height. Retains proportional heights between imported waveforms.

Entering a Manual Skew Adjustment

You can use the Manual Skew Adjust to manually change the 
measured skew and apply that new skew to displays. Since there is 
some uncertainty in all measurements, you may wish to use this option 
to create a more visually pleasing or comprehensible display. You can 
use the arrow buttons to increment or decrement the skew in 1 nsec 
increments, or you can type in a new skew value with up to picosecond 
resolution. Changes made here apply only to the currently selected 
Trigger Direction. The other measured value is not affected. Press the 
Apply button in the lower left corner to apply the new skew to current 
data. The new value will be used on future measurements also. To 
restore the originally measured skew, press the Restore Auto Deskew 
button. This applies only to the currently selected Trigger Direction.

Manually Adjusting the Skew Using the Global Markers

You may also set the skew using the global markers G1 and G2 on the 
167XX. To do this, first press the Set Skew to 0s button. This will reset 
the skew to zero. Press the Apply button in the lower left corner of the 
Infiniium<1> window to apply the new skew to current data. 

Next, open the Waveform window at the output of the Infiniium tool to 

view the non-correlated data. (Select the Workspace icon , then 
double-click the Waveform window.) You can manually deskew if you 
have a common signal that was probed with both an analysis channel 
and a scope channel. Move the G2 marker to the dual-probed edge on 
the analysis channel. Move the G1 marker to the dual-probed edge on 
the scope channel. The difference in time between these two markers 
is the skew between instruments for that edge. 

Go back to the Infiniium Advanced Tab and press Set Skew to G2-G1. 
The time between the markers will be displayed. Press the Apply 
button in the lower left corner to apply the new skew to current data. 
Open the Waveform window again and the edge will be correlated 
between instruments.
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Advanced Tab
See Also “What do the skew numbers mean?” on page 44
 
Back to “Advanced Software Features” on page 22
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Comments Tab
Comments Tab

  

The Comments Tab is a text edit area where you can place comments 
to remind you of what the current setup was used for, results you 
measured, etc. These comments are saved when you save the 
configuration. Many other tools such as Waveform and Listing also have 
comments tabs where you can document specific displays.

 

Back to “Advanced Software Features” on page 22
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Infiniium IP Address
Infiniium IP Address

The Time Correlation fixture software requires the Infiniium host name 
or IP address. To find the Infiniium host name or IP address: 

1. On the Infiniium Oscilloscope, select Utilities-> GPIB Setup....

2. The Infiniium Address is shown in the LAN Interface portion of the 
window. Ignore the brackets and text, and use only the numbers (such as 
123.45.678.90). Enter that string from the Infiniium 548XX in the Setup 
Assistant.

3. If you use a host name instead of a web address, enter it instead of the IP 
address. 

NOTE: If this string is not entered correctly or if someone changes the Infiniium’s IP 
address, the 167XX will not be able to communicate with the Infiniium 548XX. 
If the string happens to correspond to some other Infiniium 548XX on the 
network, the 167XX may find and connect to that Infiniium 548XX, giving the 
appearance that you are correctly connected when you in fact are not. If you 
enter a string that does not correspond to any device on your network, the 
software may appear to hang for up to several minutes while it searches for 
the device. Only one connection from a 167XX to a given Infiniium 548XX can 
be supported. Making multiple connections to a single Infiniium 548XX will in 
most cases cause all the connections to hang.
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Reference
Reference

The following information helps explain how the time correlation 
fixture works.

• “How the Auto Deskew Operation Works” on page 38

• “Calibration” on page 42

• “Uncertainty” on page 43

• “What do the skew numbers mean?” on page 44 
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How the Auto Deskew Operation Works
How the Auto Deskew Operation Works

Propagation Delays

The 167XX and the Infiniium 548XX are able to drive a signal out of 
their chassis when a trigger condition occurs. These signals are Port 
Out on the 167XX and Aux Out on the Infiniium 548XX. They are also 
able to arm and/or trigger on the receipt of an external signal. These 
signals are Port In on the 167XX and Aux Trig In on the Infiniium 
548XX. On both instruments there is a propagation time between when 
a trigger event occurs and when it’s output signal is driven, and a 
propagation delay between when an input signal occurs and when the 
instrument actually triggers. There will also be propagation time in the 
cable between the instruments. We call the sum of all these 
propagation times the "skew" between the instruments.

Trigger points are different

For example, you can simply connect a 50 ohm cable from the 167XX 
Port Out to the Infiniium 548XX Aux Trig In. Set a trigger condition of 
your choice on the 167XX, set the Infiniium 548XX to Edge trigger on 
Aux Trig In at 1.0 V. Run the Infiniium 548XX, run the 167XX. After the 
167XX triggers, the Infiniium 548XX will trigger. Both instruments will 
identify their trigger point. Unfortunately, because of the skew, these 
trigger points will not represent the same point in time. Unless the 
signal(s) being probed have unique identifying patterns, it may be very 
difficult or impossible to tell which edge(s) on one instrument 
correspond to which edge(s) on the other instrument.

The objective

The point of the Auto Deskew operation is to measure the skew 
between the instruments, remember the results of those 
measurements, and take those results into account when displaying 
subsequent measurements so that time correlated displays and marker 
moves can be created. 

Setup matters

It is important to be aware that the skew measurement is specific to 
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the setup used for the measurement. The skew will change for different 
models of analysis modules and different Infiniium models. It will vary 
using the same model of an analysis module in a different slot of the 
167XX chassis. It will vary based on the type and length of scope probe 
used. It will vary among the various probing options available for 
analysis modules such as flying leads, MICTOR connectors, Samtec 
connectors, etc. For the best possible time correlation you must 
perform the Auto Deskew operation with the same probing you will 
later use for measurements on your device under test.

The Cal signal

The skew is measured by probing the Cal signal on the E5850A with 
both Pod 2, Channel 0 of the analysis module and Channel 1 of the 
Infiniium 548XX. The Cal signal itself is a low frequency oscillator 
(approx. 62 kHz, approx. 16 usec period). Since the period of this 
oscillator is at least two decimal orders of magnitude greater than the 
skew between the instruments, we know that the edge nearest the 
trigger is the same edge on both instruments. It is critically important 
that the instrument that is to receive the external trigger signal is 
running, armed and waiting before the driving instrument sends the 
trigger signal. If that is not the case, the instruments could very well be 
looking at different edges of the oscillator. During the Auto Deskew 
operation and during subsequent regular single or repetitive runs, the 
E5850A ensures that the instruments are always armed and run in the 
correct sequence.

Analyzer triggers Infiniium

To measure skew in the Analyzer Triggers Infiniium direction the 
E5850 software will setup both the analysis module and the Infiniium. 
The analyzer will be placed in Timing Mode at its highest sample rate 
(shortest sample period). Labels will be defined for the "DeskewEdge" 
(the Cal signal) and "TriggerSense" signals which are provided by the 
E5850A Time Correlation Fixture. The analyzer will be configured to 
trigger on the rising edge of the "DeskewEdge" signal. The Inter-
Module Bus (IMB) will be configured to drive Port Out from the 
analysis module you selected. The Infiniium will be configured to 
trigger on its Aux Trig In line and Channel 1 will be turned on and 
configured to measure the "DeskewEdge" signal from the Time 
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Correlation Fixture. It will be set up for Single Sweep, Real Time 
Sampling Mode at its maximum Sampling Rate and maximum Memory 
Depth.

Measuring the skew

The skew is measured by first running the Infiniium, after it is armed 
the analyzer is run. The analyzer triggers on the next edge of 
"DeskewEdge", drives Port Out to the Infiniium which then triggers. 
The software retrieves the captured Channel 1 waveform from the 
Infiniium and measures the time from the trigger point to the rising 
edge on that waveform. The rising edge will occur earlier in time than 
the trigger. This time is the skew. 

An average is used

The measurement is repeated several times and the average is taken to 
be the skew. The reason for taking the average of multiple 
measurements is the fact that the analyzer is sampling the 
"DeskewEdge" signal at a regular interval. The edge may actually occur 
near the beginning or near the end of the analyzer’s sample period. The 
Infiniium is also sampling at a regular interval, generally at a much 
higher frequency (shorter period). Because of the different and 
asynchronous sampling between the two instruments a skew of +/- one 
analyzer sample period can occur in any single measurement.

Infiniium triggers analyzer

Measuring skew in the Infiniium Triggers Analyzer direction is very 
similar to the Analyzer Triggers Infiniium direction. The Infiniium is set 
up to trigger on a rising edge on Channel 1 and drive Aux Out to the 
Logic Analysis System Port In. The analysis module is configured to 
trigger on Port In. When the measurement is run, the analysis module 
is run first so it is armed and waiting for the Aux Out/Port In signal 
from the Infiniium. The Infiniium is then run, it triggers and drives the 
trigger signal to the Logic Analysis System which then triggers and fills 
analysis memory. The skew is then measured as the time between 
when the rising edge occurred and the trigger occurred in the Logic 
Analysis System. The measurement is run several times and an average 
is taken.
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The setup is ready

The analyzer pod and scope probe may now be disconnected from the 
Time Correlation Fixture and used to probe the device under test. The 
analyzer trigger and IMB setup should not be changed, they are setup 
to receive the trigger signal from the Infiniium and this is required for 
correlation. The Infiniium trigger may be setup for whatever condition 
you are looking for in the device under test. Remember that only Single 
Sweep, Real Time acquisition can be meaningfully correlated with a 
logic analyzer. After the analysis module triggers and fills its analysis 
memory the waveforms captured by the Infiniium will automatically be 
imported into the Logic Analysis System and be displayed and time 
correlated in the Waveform window.
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Calibration

The time correlation fixture measures the skew during the Auto 
Deskew operation. The software uses the skew factor in all subsequent 
runs.

After you have run Auto Deskew, you can remove the channel 
connections from the front of the E5850A time correlation fixture. All 
of your oscilloscope and logic analysis channels are available for 
probing your device under test when the calibration is complete.

Remember that the skew is affected by cable lengths, probe types, the 
instruments themselves and the particular slot an analysis module is in. 
If you change any of these you will need to perform the deskew 
operation again.
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Uncertainty 

Since the analyzer samples signals at intervals of one duration and the 
scope will usually sample at intervals of an entirely different duration 
and signals can actually transition at any point in time with any 
possible relation to the sample period(s), there will always be some 
uncertainty about when the signal actually transitioned versus when 
the analyzer noticed the transition.

Another source of uncertainty is the circuit used by the intermodule 
bus (IMB) to cross-correlate the times of trigger events from different 
modules. This circuitry has a resolution of 2 ns.

The uncertainty will always be at least +/- one timing analyzer sample 
period plus 2 ns IMB uncertainty. 

During the Auto Deskew operation the maximum and minimum skew 
are measured. If the maximum measured skew is outside the expected 
range, it can indicate that one or more of the connections to the Time 
Correlation Fixture were not made or were made incorrectly. A 
warning dialog will appear, suggesting that you check all the 
connections and run Auto Deskew again.
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What do the skew numbers mean?

The skew (which is displayed above the Trigger Direction box) is the 
average trigger delay that is introduced external to the Logic Analyzer. 
The portion of the total skew that is internal to the 167XX Logic 
Analysis System is compensated for internally on a per-run basis. This 
internally measured skew is added to the constant skew that is 
displayed to compute the total skew. The total skew is added to the 
trigger time for the Infiniium, thereby time correlating its trigger 
position with the trigger position of the analyzer.

The skew number will be positive when the Analyzer triggers Infiniium. 
This has the effect of moving the Infiniium trigger to the right in the 
Waveform window. When the Analyzer triggers the Infiniium, a delay 
occurs between the time when the Analyzer sees the trigger condition 
and when the Port Out signal arrives at the Infiniium Aux Trig In. This 
means the Infiniium will trigger at a later time than the analyzer, so its 
waveforms must be moved to the right in order for them to line up with 
Analyzer waveforms.

The skew number will be negative when the Infiniium triggers the 
Analyzer. This has the effect of moving the Infiniium trigger to the left 
in the Waveform window. When the Infiniium triggers the Analyzer, a 
delay occurs between the time when the Infiniium sees the trigger 
condition and when the Aux Out signal arrives at the 167XX Port In. 
This means that the Infiniium will trigger at an earlier time than the 
analyzer, so its waveforms must be moved to the left in order for them 
to line up with Analyzer waveforms.

In the Advanced Tab you can use the Manual Skew Adjust to change 
the fixed part of the total skew computation. This allows you to move 
the Infiniium waveforms to the right (larger numbers) or left (smaller 
numbers). This feature can be used to remove constant skew that was 
not measured during the Auto Deskew. If you use different probing 
accessories when you probe your Device Under Test than when you ran 
the Auto Deskew, you will be causing additional constant skew. This is 
one example of where Manual Skew Adjust can be useful.
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Installing the Software

Software for the E5850A may be installed on any Agilent 167XX Logic 
Analysis System.

 

Is the Infiniium Time 
Correlation Software 
Installed?

If the Infiniium Time Correlation software is installed, a button will be 
present in the lower right corner of the system window titled Time 

Correlate with Infiniium Oscilloscope. This button appears under 
the Port In and Port Out buttons as shown below.

You can install the software now, but in order to use the time 
correlation software you must connect the E5850A Time Correlation 
Fixture too.

 

To install the 
software:

1. Obtain a CD-ROM labeled Agilent 16700 Series Logic Analysis System 

Software, version A.02.20.00 or later.

2. Insert the CD-ROM in the CD drive.

3. Open the System Administration tool.

4. Select the Software Install tab.

5. Select the Install... button.
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6. In the Software Install window, select CD-ROM.

7. Select Apply.

8. Double-click AUXILIARY_SW.

9. Select E5850A.

10. Select Details... or Options... if you wish.

11. Select Apply in the Software Install window.

12. Select Install.

13. Installing this tool will cause your session to exit.

14. Select Continue. 

When the installation is complete you will need to start a session. The 
Time Correlate with Infiniium Oscilloscope button will be present in 
the lower right corner of the System window in the new session.

Next step: “Connecting the Fixture” on page 9
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Setting Up the Infiniium Time Correlation Tool 
in the Workspace

  

Overview Using the Setup Assistant is probably the easiest way for a novice user 
to set up the E5850A time correlation fixture and configure the 
software. But it is not the only way. If you regularly use the Workspace 
to set up measurement systems, you may find the procedure below to 
be a convenient way for you to set up the E5850A.

  

Set up the Workspace Ensure Analysis Module is on the Workspace

First open the Workspace on the Agilent 167XX Logic Analysis System. 
If the analysis module you wish to use is not already on the workspace, 
find its icon on the left side of the Workspace display under 
"Instrument" and drag it onto the workspace. 

Drop the Infiniium Icon onto the Analysis Module Icon

Scroll the icon display down until you find the "Utilities" icons. Drag the 
"Infiniium" icon onto the workspace and drop it onto the analysis 
module icon that is already on the workspace. A line connecting the 
two icons will appear.

Drop the Waveform Icon onto the Infiniium Icon

Scroll the icon display back up until you find the "Display" icons. Drag 
the "Waveform" icon onto the workspace and drop it onto the 
"Infiniium" icon you previously dragged onto the workspace. A line 
connecting the two icons will appear. 

This is the basic setup you will use whenever you want to correlate the 
Logic Analysis System with Infiniium. You can also drag and drop a 
Listing display on the "Infiniium" icon if you wish.
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Establish LAN 
Connection

Open the "Infiniium" tool display by right clicking on the icon and 
selecting "Display" from the drop down menu. In the display there will 
be a row of tabs near the top of the display. Select the left-most tab 
labeled "Connect". Enter the host name or IP address of the Infiniium 
you want to correlate with. Press the "Enter" key or select the "Apply" 
button in the lower left corner of the display. The Logic Analysis 
System will attempt to make a LAN connection to the Infiniium you 
specified. If it fails, a red error message will appear to the right of the 
input box where you entered the host name. If you get an error 
message check the network setup on both the Logic Analysis System 
and the Infiniium, check the host name, try again.

  

Connect the Fixture 
and Run Auto Deskew

Once the network connection is established you are ready to measure 
the skew between the instruments. Connect the E5850A Time 
Correlation Fixture as described in “Connecting the Fixture” on page 9, 
then press the green "Run Auto Deskew..." button. The skew will be 
measured in both directions. When the auto deskew process is 
complete you may disconnect the analysis pod and scope probe from 
the Time Correlation Fixture, connect them to your device under test, 
and begin making your measurements.
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Loading & Saving Configurations

You can save the configuration you set up on the Logic Analysis System 
using the File->Save Configuration... menu item which is available on 
every display in the Logic Analysis System. 

When you save a configuration that includes the E5850A, all of the 
skews you measured will be saved along with the host name of the 
Infiniium. The Infiniium setup will be also be saved in the 167XX Logic 
Analysis System’s configuration file. Infiniium oscilloscope data is not 
saved in the logic analysis system’s configuration file.

When the configuration is loaded at a later time, the Logic Analysis 
System will automatically connect to the Infiniium and restore the 
setup that was saved. Of course, if the Infiniium is not available on the 
network when the configuration is loaded this automatic connection 
and setup will fail.

If the Infiniium is a shared resource and is likely to be moved to 
another location, this option can have undesired effects. If the 
Infiniium is on the network with the same Host Name or IP Address, 
the saved configuration will be loaded into that Infiniium, possibly 
changing a setup that someone else has created.

Also, the system will probably hang if two logic analysis systems 
attempt to connect to one Infiniium oscilloscope. 

Connection to multiple Infiniium oscilloscopes at a time from one logic 
analysis system is not supported.

See Also • Loading and Saving Configuration Files (see the Agilent Technologies 

16700A/B-Series Logic Analysis System help volume) 
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Troubleshooting

Troubleshooting Information - E5850A Infiniium Time Correlation 
Fixture

Error Messages

Infiniium LAN error (see page 36)
Infiniium comm failed (see page 36)

General Troubleshooting

LAN problems (see page 63)
Unexpected or inconsistent results (see page 59)
How do I re-run the setup assistant (see page 51)
Marker moves back when I change its position (see page 61)
My Intermodule Bus (IMB) setup has changed (see page 62)

Measurement Hangs (see page 52)
General Triggering Problems (see page 53)
Pressing the Run button on the Infiniium does not run the analyzer 
(see page 56)
The Infiniium didn’t trigger when I pressed Run on the Analyzer (see 
page 57)
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Re-running the Setup Assistant

  

You can re-run the time correlation setup assistant to: 

• choose a different logic analyzer

• choose a different Infiniium

• enter a new LAN address for the Infiniium

• change the trigger direction

• re-measure the skew between instruments

• return the setup to a known condition 

To re-run the time correlation setup assistant, click on the Setup 

Assistant button at the bottom of the Infiniium<1> window. This will 
bring up the following dialog:   

Select Continue to re-run the time correlation setup assistant.
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Measurement Hangs

Measurement hangs when I change seconds/div or Volts/div on the 
Infiniium during a Group Run.

Changing the seconds/div on the Infiniium and especially changing to a 
very long sweep time (i.e. 20 s/div) can cause the scope to take a very 
long time to trigger and fill acquisition memory. This can make it 
appear that the measurement is hung. Changing the V/div on a channel 
such that the signal on that channel is clipped can have a similar effect.

Rather than changing Infiniium s/div or V/div during a Group Run, we 
suggest that you set up the Infiniium for your measurement before 
starting the Group Run. You can use the Infiniium as a stand-alone 
scope while it is connected to the 167XX logic analysis system by the 
E5850A hardware and software when a Group Run is not underway. 
You can probe your device under test with the Infiniium, run auto 
sweep or triggered sweep measurements to find your signals, and set 
up s/div, V/div, offsets, etc.

When you are ready to make a coordinated measurement, use Group 
Run on the 167XX Logic Analysis System to start the measurement. 
The E5850A software will stop the Infiniium, place it in single sweep 
mode, set memory depth to maximum, etc. The coordinated 
measurement will then be run. When the measurement is complete the 
waveforms captured by the Infiniium will be imported into the 167XX 
and time correlated.
52



Chapter 1: The Infiniium Time Correlation Fixture
General Triggering Problems
General Triggering Problems

Analyzer Triggers Infiniium

When the software is configured for Analyzer triggers Infiniium, the 
Infiniium will be configured to trigger on a rising edge of Aux Trig In at 
1.0V. If you change the Infiniium trigger, the software will automatically 
restore the Infiniium’s trigger condition to trigger on the rising edge of 
Aux Trig In at 1.0V the next time you run the logic analyzer. You may 
set any trigger condition you desire in the analyzer, since you are using 
it to trigger the Infiniium.

Infiniium Triggers Analyzer

When the software is configured for Infiniium triggers Analyzer, the 
analyzer will be configured to trigger on any pattern after being armed 
by Port In. If you change the analyzer trigger you will not be able to 
correctly time correlate the instruments. You may set any trigger 
condition you desire in the Infiniium, since you are using it to trigger 
the analyzer.

Why isn’t the red trigger marker where I expect?

Whenever you are using the E5850A you are performing a multiple 
instrument measurement. Measurements from each instrument are 
time correlated, but each instrument retains its actual trigger point. In 
a multiple instrument measurement only one of those trigger points 
can be indicated by the red trigger marker in the Waveform window. 

In the Waveform window you can select Options->Reference trigger... 
This will pop up a dialog showing the names of the instruments that are 
included in the display. Select one of the instruments to see its trigger. 
The default name for the E5850A will be "Infiniium<1>". When you 
have selected Infiniium triggers Analyzer, you could select 
"Infiniium<1>" to see where the Infiniium triggered and how analyzer 
data correlates with that trigger.

Check Cable Connections

The four BNC cables must remain connected between the logic 
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analyzer, the time correlation fixture, and the oscilloscope whenever 
you are using the time correlation feature. 

Check Probe Connections

Also, be sure your are using the correct logic analyzer cables. Trace 
them from the analyzer card to the E5850A fixture or target system. 
And be sure you are using the correct oscilloscope probe. Follow it 
from the instrument to the E5850A fixture or the target system.

Use Grounds

Your connections to the front of the time correlation fixture must 
include grounds. For example, you should connect the oscilloscope 
probe ground clip to the ground terminal on the E5850A fixture. 
Ground leads for each logic analyzer pod, and preferably each logic 
analyzer channel should be connected to a ground terminal on the 
E5850A fixture too.

Don’t Change the Setup

In the Infiniium triggers Analyzer mode, the analyzer trigger and 
intermodule bus setup should not be changed. They are configured to 
receive the trigger signal from the Infiniium as required for time 
correlation. If you need to re-run the setup assistant, click here for 
instructions on “Re-running the Setup Assistant” on page 51. In the 
Analyzer triggers Infiniium mode, you can change the logic analyzer 
trigger setup as desired for a particular measurement.

Infiniium Must be in the Correct Mode

Note that only Single Sweep, Real Time acquisition can be meaningfully 
correlated with a logic analyzer. Meaningful correlation may not be 
possible if the oscilloscope is set to sample in Equivalent Time, or if the 
oscilloscope sweep is set to Sweep or Triggered Sweep.

Ensure no one else is using the Infiniium

If someone else is using the Infiniium oscilloscope either from the front 
panel or via the LAN, the logic analysis system will not be able to 
correctly control the Infiniium.
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The logic analysis system must be in Group Run mode

The Run button on the logic analysis system’s System window will say 

GROUP when the system is in group run mode.  If you have 
changed the setup and the run button no longer says GROUP, you can 
re-run auto deskew or see “Re-running the Setup Assistant” on page 51 
to restore the logic analyzer to group run mode. 

See Also “Troubleshooting” on page 50
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The logic analyzer didn’t trigger

The Infiniium’s Run 
button does not run 
the analyzer

Pressing the Run button on the Infiniium will never cause the 167XX 
analyzer to run and can not be used to start a correlated measurement. 
The Run button on the Infiniium will only run the Infiniium.

Use the group run button  on the logic analysis system to make 
your time correlated measurement, whether you’ve set the Infiniium to 
trigger the analyzer or the analyzer to trigger the Infiniium.

A correlated measurement can only be made by setting up the E5850A 
software on the 167XX and running Auto Deskew. After that, the 
167XX logic analysis system’s Run button will cause the 167XX and 
Infiniium to both be started in the correct order and a correlated 
measurement will be made. The 167XX logic analysis system must be 
in Group Run mode.   

See Also “General Triggering Problems” on page 53
“The Infiniium didn't trigger” on page 57
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The Infiniium didn’t trigger

  

The logic analyzer 
didn’t run the 
oscilloscope

Are the analyzer and the oscilloscope on the LAN?

Ensure that the logic analysis system is connected to the oscilloscope 
via the LAN. 
See “Connect the LAN” on page 10.

Ensure that the Infiniium’s IP address has not been changed

If it has been changed, you will need to re-run the time correlation 
setup assistant. 
See “Re-running the Setup Assistant” on page 51.

Ensure you are the only user

Someone else may be using the Infiniium oscilloscope over the LAN. 
Ensure that you are the only user of the oscilloscope. You may need to 
contact your system administrator for help in determining whether you 
are the only one using the oscilloscope.

  

The logic analysis 
system must be in 
Group Run mode

The Run button on the logic analysis system's System window will say 

GROUP when the system is in group run mode. 

Time correlation setup assistant sets up the intermodule bus

The Time Correlation Setup Assistant configures the intermodule bus 
for time correlated measurements. If you change the intermodule bus 
(IMB) setup, the time correlated measurements won't work. See “Re-
running the Setup Assistant” on page 51.

Running Auto Deskew sets up the Intermodule Bus

Running Auto Deskew sets up the Intermodule Bus to enable triggering 
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between the Infiniium and the analyzer you are using. When the auto 
deskew is complete, you may not remove the analyzer you used for 
deskew from Group Run. If you do, you will need to run auto deskew 
again. 

Adding other instruments to the group

You may add other instruments to the group. They may be armed 
directly from group run or from the analyzer you used for the deskew 
process. Instruments that are added to Group Run will be automatically 
correlated with the analyzer that you used for deskewing with the 
Infiniium.

Trigger direction setting modifies intermodule bus configuration

The "Analyzer triggers Infiniium" and "Infiniium triggers Analyzer" 
buttons in the E5850A window will modify the intermodule bus setup 
as appropriate for the trigger direction.
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Unexpected or Inconsistent Results

If you are experiencing unexpected or inconsistent deskew results, 
check the following items.

Check Cable Connections

Your connections to the front of the time correlation fixture must 
include grounds. For example, you should connect the oscilloscope 
probe ground clip to the ground terminal on the E5850A fixture. 
Ground leads for each logic analyzer pod, and preferably each logic 
analyzer channel should be connected to a ground terminal on the 
E5850A fixture too.

Check Probe Connections

Also, be sure your are using the correct logic analyzer cables. Trace 
them from the analyzer card to the E5850A fixture or target system. 
And be sure you are using the correct oscilloscope probe. Follow it 
from the instrument to the E5850A fixture or the target system.

Don’t Change the Setup

If the trigger direction is set to Infiniium triggers Analyzer the logic 
analyzer trigger and intermodule bus setup should not be changed 
after running the time correlation setup assistant. They are configured 
to receive the trigger signal from the Infiniium as required for time 
correlation. If you need to re-run the setup assistant, click here for 
instructions on “Re-running the Setup Assistant” on page 51.

Infiniium Must be in the Correct Mode

Note that only Single Sweep, Real Time acquisition can be meaningfully 
correlated with a logic analyzer. Meaningful correlation may not be 
possible if the oscilloscope is set to sample in Equivalent Time, or if the 
oscilloscope sweep is set to Auto Sweep or Triggered Sweep.

Ensure no one else is using the Infiniium

If someone else is using the Infiniium oscilloscope either from the front 
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panel or via the LAN, the logic analysis system will not be able to 
correctly control the Infiniiu m.
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Marker snaps back when I move it

Markers, and in particular marker moves, are not identically 
implemented in the 167XX Logic Analysis System and the Infiniium 
oscilloscope. 

Infiniium marker snaps back

When G1 follows Ax, G2 follows Bx are enabled and Ax follows G1, 

Bx follows G2 are disabled, moving G1 or G2 will not produce a 
permanent marker move because the Infiniium will move the marker 
back. 

In the 167XX Logic Analysis System the new marker position is sent to 
all tools that are displaying a correlated measurement when the move 
completes. Moving a 167XX marker will cause a move of an Infiniium 
marker only when the move is complete (when you’re done dragging 
and dropping the marker). 

The Infiniium doesn’t have this same facility, so the 167XX polls the 
Infiniium for its marker positions, updating the 167XX markers as the 
Infiniium markers move. Infiniium marker moves are updated 
continuously rather than at the end of a marker move. 

See also “Markers Tab and Coordinated Marker Moves” on page 29.
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My IMB setup has changed

Running Auto Deskew, whether through the time correlation setup 
assistant or using the Run Auto Deskew button, will reconfigure the 
intermodule bus. If you need to use a unique IMB setup, run Auto 
Deskew and then reconfigure the intermodule bus. You may want to 
save your configuration so it can be used at a later time.
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LAN Problems

If you see an "Infiniium LAN error" message:

• Check the LAN connections to the Infiniium and the logic analysis system. 

• Check with your LAN administrator to ensure that the LAN is currently 
functioning.* In the Connect Tab of the E5850A software on the 167XX 
make sure the correct IP address is entered in the "Infiniium Host Name or 
IP" field and press "Apply" in the lower left corner. 

• If the system still fails to connect, open the System Administration 
window. Select the Networking tab. Select the Ping... button. Enter the IP 
address of the Infiniium, then select OK. If errors are reported, ask your 
LAN administrator to help you establish networking on the 167XX and 
Infiniium. If Ping does not report any errors, the problem may be in the 
Standard Instrument Control Library that both instruments use to 
communicate over LAN. Cycle power on both instruments. If problems 
persist, contact Agilent Technologies for technical support. 

Only one logic analysis system may connect to the Infiniium via the LAN

If two logic analysis systems try to connect to the same Infiniium, the 
network will probably hang. Connection to multiple Infiniium 
oscilloscopes from one logic analysis system is not supported.

  

See also The note in “Infiniium IP Address” on page 36.
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absolute  Denotes the time period 
or count of states between a captured 
state and the trigger state. An 
absolute count of -10 indicates the 
state was captured ten states before 
the trigger state was captured.

acquisition  Denotes one complete 
cycle of data gathering by a 
measurement module. For example, 
if you are using an analyzer with 
128K memory depth, one complete 
acquisition will capture and store 
128K states in acquisition memory.

analysis probe  A probe connected 
to a microprocessor or standard bus 
in the device under test. An analysis 
probe provides an interface between 
the signals of the microprocessor or 
standard bus and the inputs of the 
logic analyzer. Also called a 
preprocessor.

analyzer 1  In a logic analyzer with 
two machines, refers to the machine 
that is on by default. The default 
name is Analyzer<N>, where N is 
the slot letter.

analyzer 2  In a logic analyzer with 
two machines, refers to the machine 
that is off by default. The default 
name is Analyzer<N2>, where N is 
the slot letter.

arming  An instrument tool must be 
 

armed before it can search for its 
trigger condition. Typically, 
instruments are armed immediately 
when Run or Group Run is selected. 
You can set up one instrument to arm 
another using the Intermodule 

Window. In these setups, the second 
instrument cannot search for its 
trigger condition until it receives the 
arming signal from the first 
instrument. In some analyzer 
instruments, you can set up one 
analyzer machine to arm the other 
analyzer machine in the Trigger 

Window. 

asterisk (*)  See edge terms, 
glitch, and labels.

bits  Bits represent the physical logic 
analyzer channels. A bit is a channel 
that has or can be assigned to a label. 
A bit is also a position in a label.

card  This refers to a single 
instrument intended for use in the 
Agilent Technologies 16600A-series 
or 16700A/B-series mainframes. One 
card fills one slot in the mainframe. A 
module may comprise a single card or 
multiple cards cabled together.

channel  The entire signal path from 
the probe tip, through the cable and 
module, up to the label grouping. 

click  When using a mouse as the 
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pointing device, to click an item, 
position the cursor over the item. 
Then quickly press and release the 
left mouse button.

clock channel  A logic analyzer 
channel that can be used to carry the 
clock signal. When it is not needed 
for clock signals, it can be used as a 
data channel, except in the Agilent 
Technologies 16517A.

context record  A context record is 
a small segment of analyzer memory 
that stores an event of interest along 
with the states that immediately 
preceded it and the states that 
immediately followed it.

context store  If your analyzer can 
perform context store 
measurements, you will see a button 
labeled Context Store under the 
Trigger tab. Typical context store 
measurements are used to capture 
writes to a variable or calls to a 
subroutine, along with the activity 
preceding and following the events. A 
context store measurement divides 
analyzer memory into a series of 
context records. If you have a 64K 
analyzer memory and select a 16-
state context, the analyzer memory is 
divided into 4K 16-state context 
records. If you have a 64K analyzer 
memory and select a 64-state 
context, the analyzer memory will be 
66
divided into 1K 64-state records.

count  The count function records 
periods of time or numbers of state 
transactions between states stored in 
memory. You can set up the analyzer 
count function to count occurrences 
of a selected event during the trace, 
such as counting how many times a 
variable is read between each of the 
writes to the variable. The analyzer 
can also be set up to count elapsed 
time, such as counting the time spent 
executing within a particular function 
during a run of your target program.

cross triggering  Using intermodule 
capabilities to have measurement 
modules trigger each other. For 
example, you can have an external 
instrument arm a logic analyzer, 
which subsequently triggers an 
oscilloscope when it finds the trigger 
state.

data channel  A channel that 
carries data. Data channels cannot be 
used to clock logic analyzers.

data field  A data field in the pattern 
generator is the data value associated 
with a single label within a particular 
data vector.

data set  A data set is made up of all 
labels and data stored in memory of 
any single analyzer machine or 
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instrument tool. Multiple data sets 
can be displayed together when 
sourced into a single display tool. The 
Filter tool is used to pass on partial 
data sets to analysis or display tools.

debug mode  See monitor.

delay  The delay function sets the 
horizontal position of the waveform 
on the screen for the oscilloscope and 
timing analyzer. Delay time is 
measured from the trigger point in 
seconds or states.

demo mode  An emulation control 
session which is not connected to a 
real target system. All windows can 
be viewed, but the data displayed is 
simulated. To start demo mode, 
select Start User Session from the 
Emulation Control Interface and 
enter the demo name in the 
Processor Probe LAN Name field. 
Select the Help button in the Start 

User Session window for details.

deskewing  To cancel or nullify the 
effects of differences between two 
different internal delay paths for a 
signal. Deskewing is normally done 
by routing a single test signal to the 
inputs of two different modules, then 
adjusting the Intermodule Skew so 
that both modules recognize the 
signal at the same time.
 

device under test  The system 
under test, which contains the 
circuitry you are probing. Also known 
as a target system.

don’t care  For terms, a "don’t care" 
means that the state of the signal 
(high or low) is not relevant to the 
measurement. The analyzer ignores 
the state of this signal when 
determining whether a match occurs 
on an input label. "Don’t care" signals 
are still sampled and their values can 
be displayed with the rest of the data. 
Don’t cares are represented by the X 
character in numeric values and the 
dot (.) in timing edge specifications.

dot (.)  See edge terms, glitch, 
labels, and don’t care.

double-click  When using a mouse 
as the pointing device, to double-click 
an item, position the cursor over the 
item, and then quickly press and 
release the left mouse button twice.

drag and drop  Using a Mouse:
Position the cursor over the item, and 
then press and hold the left mouse 

button. While holding the left mouse 
button down, move the mouse to 
drag the item to a new location. When 
the item is positioned where you 
want it, release the mouse button.
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Using the Touchscreen:
Position your finger over the item, 
then press and hold finger to the 
screen. While holding the finger 
down, slide the finger along the 
screen dragging the item to a new 
location. When the item is positioned 
where you want it, release your 
finger.

edge mode  In an oscilloscope, this 
is the trigger mode that causes a 
trigger based on a single channel 
edge, either rising or falling.

edge terms  Logic analyzer trigger 
resources that allow detection of 
transitions on a signal. An edge term 
can be set to detect a rising edge, 
falling edge, or either edge. Some 
logic analyzers can also detect no 
edge or a glitch on an input signal. 
Edges are specified by selecting 
arrows. The dot (.) ignores the bit. 
The asterisk (*) specifies a glitch on 
the bit. 

emulation module  A module 
within the logic analysis system 
mainframe that provides an 
emulation connection to the debug 
port of a microprocessor. An E5901A 
emulation module is used with a 
target interface module (TIM) or an 
analysis probe. An E5901B emulation 
module is used with an E5900A 
emulation probe.
68
emulation probe  The stand-alone 
equivalent of an emulation module. 
Most of the tasks which can be 
performed using an emulation 
module can also be performed using 
an emulation probe connected to 
your logic analysis system via a LAN.

emulator  An emulation module or 
an emulation probe.

Ethernet address  See link-level 

address.

events  Events are the things you 
are looking for in your target system. 
In the logic analyzer interface, they 
take a single line. Examples of events 
are Label1 = XX and Timer 1 > 400 

ns.

filter expression  The filter 
expression is the logical OR 
combination of all of the filter terms. 
States in your data that match the 
filter expression can be filtered out or 
passed through the Pattern Filter. 

filter term  A variable that you 
define in order to specify which 
states to filter out or pass through. 
Filter terms are logically OR’ed 
together to create the filter 
expression. 

Format  The selections under the 
logic analyzer Format tab tell the 
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logic analyzer what data you want to 
collect, such as which channels 
represent buses (labels) and what 
logic threshold your signals use.

frame  The Agilent Technologies 
16600A-series or 16700A/B-series 
logic analysis system mainframe. See 
also logic analysis system.

gateway address  An IP address 
entered in integer dot notation. The 
default gateway address is 0.0.0.0, 
which allows all connections on the 
local network or subnet. If 
connections are to be made across 
networks or subnets, this address 
must be set to the address of the 
gateway machine.

glitch  A glitch occurs when two or 
more transitions cross the logic 
threshold between consecutive 
timing analyzer samples. You can 
specify glitch detection by choosing 
the asterisk (*) for edge terms under 
the timing analyzer Trigger tab.

grouped event  A grouped event is 
a list of events that you have 
grouped, and optionally named. It can 
be reused in other trigger sequence 
levels. Only available in Agilent 
Technologies 16715A, 16716A, and 
16717A logic analyzers.

held value  A value that is held until 
 

the next sample. A held value can 
exist in multiple data sets.

immediate mode  In an 
oscilloscope, the trigger mode that 
does not require a specific trigger 
condition such as an edge or a 
pattern. Use immediate mode when 
the oscilloscope is armed by another 
instrument.

interconnect cable  Short name for 
module/probe interconnect cable.

intermodule bus  The intermodule 
bus (IMB) is a bus in the frame that 
allows the measurement modules to 
communicate with each other. Using 
the IMB, you can set up one 
instrument to arm another. Data 
acquired by instruments using the 
IMB is time-correlated.

intermodule  Intermodule is a term 
used when multiple instrument tools 
are connected together for the 
purpose of one instrument arming 
another. In such a configuration, an 
arming tree is developed and the 
group run function is designated to 
start all instrument tools. Multiple 
instrument configurations are done in 
the Intermodule window.

internet address  Also called 
Internet Protocol address or IP 
address. A 32-bit network address. It 
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is usually represented as decimal 
numbers separated by periods; for 
example, 192.35.12.6. Ask your LAN 
administrator if you need an internet 
address.

labels  Labels are used to group and 
identify logic analyzer channels. A 
label consists of a name and an 
associated bit or group of bits. Labels 
are created in the Format tab. 

line numbers  A line number (Line 
#s) is a special use of symbols. Line 
numbers represent lines in your 
source file, typically lines that have 
no unique symbols defined to 
represent them. 

link-level address  Also referred to 
as the Ethernet address, this is the 
unique address of the LAN interface. 
This value is set at the factory and 
cannot be changed. The link-level 
address of a particular piece of 
equipment is often printed on a label 
above the LAN connector. An 
example of a link-level address in 
hexadecimal: 0800090012AB.

local session  A local session is 
when you run the logic analysis 
system using the local display 
connected to the product hardware. 

logic analysis system  The Agilent 
Technologies 16600A-series or 
70
16700A/B-series mainframes, and all 
tools designed to work with it. 
Usually used to mean the specific 
system and tools you are working 
with right now.

machine  Some logic analyzers allow 
you to set up two measurements at 
the same time. Each measurement is 
handled by a different machine. This 
is represented in the Workspace 
window by two icons, differentiated 
by a 1 and a 2 in the upper right-hand 
corner of the icon. Logic analyzer 
resources such as pods and trigger 
terms cannot be shared by the 
machines.

markers  Markers are the green and 
yellow lines in the display that are 
labeled x, o, G1, and G2. Use them to 
measure time intervals or sample 
intervals. Markers are assigned to 
patterns in order to find patterns or 
track sequences of states in the data. 
The x and o markers are local to the 
immediate display, while G1 and G2 
are global between time correlated 
displays.

master card  In a module, the 
master card controls the data 
acquisition or output. The logic 
analysis system references the 
module by the slot in which the 
master card is plugged. For example, 
a 5-card Agilent Technologies 16555D 
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would be referred to as Slot C: 

machine because the master card is 
in slot C of the mainframe. The other 
cards of the module are called 
expansion cards.

menu bar  The menu bar is located 
at the top of all windows. Use it to 
select File operations, tool or system 
Options, and tool or system level 
Help.

message bar  The message bar 
displays mouse button functions for 
the window area or field directly 
beneath the mouse cursor. Use the 
mouse and message bar together to 
prompt yourself to functions and 
shortcuts.

module/probe interconnect cable  

The module/probe interconnect cable 
connects an E5901B emulation 
module to an E5900B emulation 
probe. It provides power and a serial 
connection. A LAN connection is also 
required to use the emulation probe.

module  An instrument that uses a 
single timebase in its operation. 
Modules can have from one to five 
cards functioning as a single 
instrument. When a module has more 
than one card, system window will 
show the instrument icon in the slot 
of the master card.
 

monitor  When using the Emulation 
Control Interface, running the 
monitor means the processor is in 
debug mode (that is, executing the 
debug exception) instead of 
executing the user program.

panning  The action of moving the 
waveform along the timebase by 
varying the delay value in the Delay 
field. This action allows you to 
control the portion of acquisition 
memory that will be displayed on the 
screen. 

pattern mode  In an oscilloscope, 
the trigger mode that allows you to 
set the oscilloscope to trigger on a 
specified combination of input signal 
levels.

pattern terms  Logic analyzer 
resources that represent single states 
to be found on labeled sets of bits; for 
example, an address on the address 
bus or a status on the status lines. 

period (.)  See edge terms, glitch, 
labels, and don’t care.

pod pair  A group of two pods 
containing 16 channels each, used to 
physically connect data and clock 
signals from the unit under test to the 
analyzer. Pods are assigned by pairs 
in the analyzer interface. The number 
of pod pairs avalaible is determined 
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by the channel width of the 
instrument.

pod  See pod pair

point  To point to an item, move the 
mouse cursor over the item, or 
position your finger over the item.

preprocessor  See analysis probe.

primary branch  The primary 
branch is indicated in the Trigger 

sequence step dialog box as either 
the Then find or Trigger on 
selection. The destination of the 
primary branch is always the next 
state in the sequence, except for the 
Agilent Technologies 16517A. The 
primary branch has an optional 
occurrence count field that can be 
used to count a number of 
occurrences of the branch condition. 
See also secondary branch.

probe  A device to connect the 
various instruments of the logic 
analysis system to the target system. 
There are many types of probes and 
the one you should use depends on 
the instrument and your data 
requirements. As a verb, "to probe" 
means to attach a probe to the target 
system.

processor probe  See emulation 

probe.
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range terms  Logic analyzer 
resources that represent ranges of 
values to be found on labeled sets of 
bits. For example, range terms could 
identify a range of addresses to be 
found on the address bus or a range 
of data values to be found on the data 
bus. In the trigger sequence, range 
terms are considered to be true when 
any value within the range occurs.

relative  Denotes time period or 
count of states between the current 
state and the previous state. 

remote display  A remote display is 
a display other than the one 
connected to the product hardware. 
Remote displays must be identified to 
the network through an address 
location.

remote session  A remote session is 
when you run the logic analyzer using 
a display that is located away from 
the product hardware. 

right-click  When using a mouse for 
a pointing device, to right-click an 
item, position the cursor over the 
item, and then quickly press and 
release the right mouse button.

sample  A data sample is a portion of 
a data set, sometimes just one point. 
When an instrument samples the 
target system, it is taking a single 
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measurement as part of its data 
acquisition cycle.

Sampling  Use the selections under 
the logic analyzer Sampling tab to tell 
the logic analyzer how you want to 
make measurements, such as State 
vs. Timing.

secondary branch  The secondary 
branch is indicated in the Trigger 

sequence step dialog box as the Else 

on selection. The destination of the 
secondary branch can be specified as 
any other active sequence state. See 
also primary branch.

session  A session begins when you 
start a local session or remote 

session from the session manager, 
and ends when you select Exit from 
the main window. Exiting a session 
returns all tools to their initial 
configurations.

skew  Skew is the difference in 
channel delays between 
measurement channels. Typically, 
skew between modules is caused by 
differences in designs of 
measurement channels, and 
differences in characteristics of the 
electronic components within those 
channels. You should adjust 
measurement modules to eliminate 
as much skew as possible so that it 
does not affect the accuracy of your 
 

measurements.

state measurement  In a state 
measurement, the logic analyzer is 
clocked by a signal from the system 
under test. Each time the clock signal 
becomes valid, the analyzer samples 
data from the system under test. 
Since the analyzer is clocked by the 
system, state measurements are 
synchronous with the test system. 

store qualification  Store 
qualification is only available in a 
state measurement, not timing 

measurements. Store qualification 
allows you to specify the type of 
information (all samples, no samples, 
or selected states) to be stored in 
memory. Use store qualification to 
prevent memory from being filled 
with unwanted activity such as no-
ops or wait-loops. To set up store 
qualification, use the While storing 
field in a logic analyzer trigger 
sequence dialog.

subnet mask  A subnet mask blocks 
out part of an IP address so that the 
networking software can determine 
whether the destination host is on a 
local or remote network. It is usually 
represented as decimal numbers 
separated by periods; for example, 
255.255.255.0. Ask your LAN 
administrator if you need a the 
subnet mask for your network.
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symbols  Symbols represent 
patterns and ranges of values found 
on labeled sets of bits. Two kinds of 
symbols are available: 

• Object file symbols - Symbols 
from your source code, and 
symbols generated by your 
compiler. Object file symbols may 
represent global variables, 
functions, labels, and source line 
numbers. 

• User-defined symbols - Symbols 
you create. 

Symbols can be used as pattern and 
range terms for: 

• Searches in the listing display.

• Triggering in logic analyzers and 
in the source correlation trigger 
setup.

• Qualifying data in the filter tool 
and system performance analysis 
tool set. 

system administrator  The system 
administrator is a person who 
manages your system, taking care of 
such tasks as adding peripheral 
devices, adding new users, and doing 
system backup. In general, the 
system administrator is the person 
you go to with questions about 
implementing your software.
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target system  The system under 
test, which contains the 
microprocessor you are probing.

terms  Terms are variables that can 
be used in trigger sequences. A term 
can be a single value on a label or set 
of labels, any value within a range of 
values on a label or set of labels, or a 
glitch or edge transition on bits 
within a label or set of labels.

TIM  A TIM (Target Interface 
Module) makes connections between 
the cable from the emulation module 
or emulation probe and the cable to 
the debug port on the system under 
test. 

time-correlated  Time correlated 
measurements are measurements 
involving more than one instrument 
in which all instruments have a 
common time or trigger reference.

timer terms  Logic analyzer 
resources that are used to measure 
the time the trigger sequence 
remains within one sequence step, or 
a set of sequence steps. Timers can 
be used to detect when a condition 
lasts too long or not long enough. 
They can be used to measure pulse 
duration, or duration of a wait loop. A 
single timer term can be used to 
delay trigger until a period of time 
after detection of a significant event. 
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timing measurement  In a timing 
measurement, the logic analyzer 
samples data at regular intervals 
according to a clock signal internal to 
the timing analyzer. Since the 
analyzer is clocked by a signal that is 
not related to the system under test, 
timing measurements capture traces 
of electrical activity over time. These 
measurements are asynchronous 
with the test system. 

tool icon  Tool icons that appear in 
the workspace are representations of 
the hardware and software tools 
selected from the toolbox. If they are 
placed directly over a current 
measurement, the tools automatically 
connect to that measurement. If they 
are placed on an open area of the 
main window, you must connect them 
to a measurement using the mouse. 

toolbox  The Toolbox is located on 
the left side of the main window. It is 
used to display the available 
hardware and software tools. As you 
add new tools to your system, their 
icons will appear in the Toolbox.

tools  A tool is a stand-alone piece of 
functionality. A tool can be an 
instrument that acquires data, a 
display for viewing data, or a post-
processing analysis helper. Tools are 
represented as icons in the main 
window of the interface. 
 

trace  See acquisition.

trigger sequence  A trigger 
sequence is a sequence of events that 
you specify. The logic analyzer 
compares this sequence with the 
samples it is collecting to determine 
when to trigger.

trigger specification  A trigger 
specification is a set of conditions 
that must be true before the 
instrument triggers.

trigger  Trigger is an event that 
occurs immediately after the 
instrument recognizes a match 
between the incoming data and the 
trigger specification. Once trigger 
occurs, the instrument completes its 
acquisition, including any store 
qualification that may be specified.

workspace  The workspace is the 
large area under the message bar and 
to the right of the toolbox. The 
workspace is where you place the 
different instrument, display, and 
analysis tools. Once in the workspace, 
the tool icons graphically represent a 
complete picture of the 
measurements.

zooming  In the oscilloscope or 
timing analyzer, to expand and 
contract the waveform along the time 
base by varying the value in the s/Div 
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field. This action allows you to select 
specific portions of a particular 
waveform in acquisition memory that 
will be displayed on the screen. You 
can view any portion of the waveform 
record in acquisition memory. 
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correlation fixture, 8
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index entry, adjective, 29, 35
Infiniium oscilloscope, time 

correlation with, 8
Infiniium setup, saving, 32
Infiniium Time Correlation Tool, 2
IP address, Infiniium, 36

L

loading configuration files, time 
correlation tool, 49

M

main system help page, 2

N

network connection, point-to-
point, 11

O

oscilloscope triggering skew, 2
oscilloscope, external, time 

correlation, 8

S

saving configuration files, time 
correlation tool, 49

setup assistant, time correlation, 
20

skew, Infiniium, manual 
adjustment, 32

T

time correlation fixture, 8
time correlation fixture, accuracy, 

43
 

time correlation fixture, advanced 
tab, 32

time correlation fixture, analyzer 
selection, 26

time correlation fixture, back view, 
19

time correlation fixture, 
calibration, 42

time correlation fixture, 
configuring software, 20, 22

time correlation fixture, 
connecting, 9

time correlation fixture, front view, 
18

time correlation fixture, how it 
works, 38

time correlation fixture, Infiniium 
host name, 27

time correlation fixture, 
intermodule bus, 62

time correlation fixture, LAN 
problems, 63

time correlation fixture, markers, 
marker, 61

time correlation fixture, rear view, 
19

time correlation fixture, reference, 
37

time correlation fixture, skew, 44
time correlation fixture, trigger 

direction, 25
time correlation fixture, 

uncertainty, 43
time correlation tool, installing 

software, 45
time correlation tool, making a 

measurement, 23
time correlation tool, workspace, 

47
time correlation, BNC cables, 14
time correlation, connecting 

analyzer, 16
time correlation, connecting LAN, 
10

troubleshooting, time correlation 
setup, 50

troubleshooting, time correlation 
setup assistant, 51

W

warning messages, disabling, 32
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